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Session 1: Create Tables

View of Tables

You can work on tables in two views namely the Design view and Datasheet view.

Design view: In Design view, you can enter the field names, their data types and description using the ‘Grid’

pane and set the field properties using ‘Field Properties’ pane.

Datasheet View: Data can be entered the into table using the Datasheet view. When you double-click the

table name in the database window, the table opens in the Datasheet view.
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Creating Tables

The steps for creating a table are as follows:

1. To create a table, open the database, go to the menu and click on the ‘Table’ option.

2. A new table will be created with the name ‘Table 1’. You can see the table name in the navigation
pane.

3. Double-click on ‘Table 1’.

4. Then, ‘Table 1’ is opened in datasheet view, where you can change its name as per your
requirement.

5. Now, right-click on ‘Table 1’ and select the data type for the particular field.
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Import Data

The steps to import data from a file are as follow:

We can either enter data into the fields or import it from external sources.

1. To import data, go to the ‘External Data’ tab, click on the ‘New Data Dource’ option and select the

option from the drop-down list.

2. Let us say, select the ‘From File’ option. Go to the ‘Excel’ option to import data from the excel file.

3. ‘Get External Data’ wizard will be opened. Select the ‘Browse’ option and set the path for the source

file.

4. Among the three options, select the first option and click ‘OK’.
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The steps to import data from the database are:

1. To import data, go to the ‘External data’ tab, click on the ‘New Data Source’ option and select the

option from the drop-down list.

2. Select the ‘From Database’ option.

3. The ‘Import Objects’ wizard will be opened.

4. Select the table you want to import from the database.

5. Click on the ‘OK’ button.

6. Click on the ‘Options’ button for advanced options.

7. Now a new wizard with an ‘Imported Successful’ message will be opened.

8. And then click on the ‘Close’ button.
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Create Linked Tables

The steps to create a linked table are as follows:

The linked tables option allows the users to access data without importing. Users can view and modify data in

both source and destination files without creating two copies of the same data.

1. To create the linked table, select the path. Click on the ‘Link to the Data Source’ option by creating a

linked table option and clicking on the ‘OK’ button.

2. Then, a link table wizard will be displayed. Select the table among the list and click on the ‘OK’ tab.

3. The linked table now appears in the left navigation pane. You can always identify a linked table by the

little arrow icon to its left.

You can now open them in the Datasheet view and update the data as required.
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Import Tables from Other Databases

The steps for importing tables from another database are:

1. Select the table in the navigation pane and right-click. Choose ‘Import’ and then ‘Access Database’.

2. The ‘Get External Data’ wizard will be opened. There you can browse the database from the current

location.

3. Select the database path. Later, select the ‘Import Tables, Queries, Forms and Modules into the

Current Database’ option and click ‘OK’.

4. The ‘Import Objects’ wizard will be opened. Select the table to import and click ‘OK’. Click on the

‘Options’ button for advanced options.

5. The wizard shows the ‘Import Successful’ message.
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Session 2: Manage Tables

Hide and Unhide Table Fields

Microsoft Access allows users to hide and unhide table fields. Hiding a data field means keeping it out of sight.

This feature is useful in situations where a user likes to see two non-adjacent fields together.

The steps to hide table fields are:

1. To hide fields, open the table in the Datasheet view.

Right-Click on the field that has to be hidden.

Click on the ‘Hide Fields’ option in the list.

Then the selected field will be hidden.

2. Whenever we click on the ‘Hide field’ option, the selected field is hidden.
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The steps to unhide table fields are:

1. If the user wants to unhide the field: right-click on any of the fields in the table and click on the ‘Unhide
Option’ to enable the hidden field.

2. A wizard with several fields would be displayed. Select the desired field and uncheck the box.

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

Delete a Table Field

The steps to delete a table field are:

1. To delete a table field, open the table in the Design view.

2. Select the field to be deleted. Click on the ‘Delete Rows’ option in the ‘Tools’ group on the ‘Design’ tab.

Before permanently deleting a field, Microsoft Access displays a warning box confirming whether you

want to delete the field permanently. Click on the ‘Yes’ button.
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Add Row Values in a Table, Add Description to a Field

The steps to add row values in a table are:

1. Open the table in the Datasheet view

2. Select the field which has numerical values

3. Go to the ‘Home’ tab and look for the summation symbol

Note that addition is generally applicable to numerical values

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

______________________________________________________________________________________

The steps to add a description to a field are:

1. The field description helps new users understand what the field contains and its importance.

2. To add a description, make sure the table is in the design view. Click on the ‘Field Description’ box
and type the description.
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Session 3: Manage Table Records

Find and Replace Data

Users can find and replace data. To find, the users need to give a ‘keyword’ to search in the entire large
database.

To replace, the users need to enter the alternative word for the ‘keyword’.
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The steps to find and replace data in a table are:

1. Go to the ‘Home’ tab and look for the ‘Find’ option.

2. The ‘Find and Replace’ dialog box appears. Select the ‘Find’ field and type the text to search. And
then select the ‘Replace With’ field and type the text to replace the keyword with. Later, press the
‘Replace All’ button to change the entire database.

3. Click on the ‘Yes’ tab to apply the changes after replacing the text.
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Filtering Records, Deleting Records

Filtering helps display only required data from the database and hide the rest.

Steps for filtering records are:

1. Open the table in the Datasheet view.

2. Select the field you want to filter.

3. Click on the ‘Option’ tab in the ‘Sort & Filter’ group on the ‘Home’ tab.

4. A drop-down list with a filter option will be displayed. Select the option.

5. Now the table is applied by filter on the ‘Course’ field.
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The ‘Filter’ option hides unwanted data, while the ‘Delete’ option will remove the selected data permanently.

Steps for deleting a record are:

1. To delete a record, open the table in the Datasheet view.

2. Select the record to delete.
Right-click on the desired row or record.

3. A drop-down menu with a delete option pops up. Select the ‘Delete Record’ option.
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4. A warning message will be given to confirm the deletion. Click on the ‘Yes’ tab to delete or the
‘No’ tab to retain the record.
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Session 4: Create and Modify Fields

Field Validation Rules

MS Access uses routines called ‘Validation Rules’ that check for correctness, meaningfulness and security of
data.

Field validation rules specify a criterion that all valid field values must meet.
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Record Validation Rules

 Record validation rules specify a condition that all valid records must satisfy.

 You can compare values across different fields using a record validation rule.

 Open the ‘Property’ sheet showing table properties. The validation rule added here is applicable to
all records of the table.
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Change Field Captions, Size, Data Types

Steps to change field caption are:

1. Open the table in design view and select one field.

2. Go to the ‘General’ tab below the table and select the ‘Caption’ field and fill in the text.

3. Now the selected field is changed to the new caption.
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Steps to change field data types are:

1. Open table in design view.

2. Locate the field to be changed.

3. Select a new data type from the list in the ‘Data Type’ column.

4. Save the change.
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Steps to change field size are:

1. Open the table in the design view and select the field.

2. Go to the ‘General’ tab. Select the ‘Field Size’ option and set the size.

Note that the selected field is a short text data type. The maximum number of characters allowed in
the field is 255. The field is now fixed as 100.

3. Then an error message is displayed indicating some content will be lost as the data size has reduced
from 255 characters to 100 characters.

So, be cautious when changing the field size.
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Auto-increment Setting

MS Access offers an auto-increment feature. When applied to a numeric data field, a sequential number is
generated automatically whenever a new row is added.

Steps to enable auto-increment are:

1. In the ‘Navigation’ pane, right-click the table to which you want to add the ‘AutoNumber’ and
click ‘Design View’.

2. Locate the first available empty row in the table design grid.

3. In the ‘Data Type’ field, click the drop-down arrow and click ‘AutoNumber’.

4. Under ‘Field Properties’, in ‘New Values’, click Increment to use incrementing numeric values
or click ‘Random’ to use random numbers.
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Default Setting

The default value is a pre-determined value fixed by the database for a particular field. For numerical value
fields, the default value is zero.

Steps to set a default value are:

1. In the ‘Navigation’ pane, right-click on the table that you want to change and then
click ‘Design View.’

2. Select the field that you want to change.

3. On the ‘General’ tab, type a value in the ‘Default Value’ property box.

4. The value you can enter depends on the data type that is set for the field.

5. Save your changes.
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Masking, Input Masking

Masking hides data from unauthorised viewers. To apply input masking, it is important that the format of the
input values is consistent.

Steps to do input masking are:

1. Select the table in the design view. Click on the field to add the input mask.

2. Under ‘Field Properties’, on the ‘General’ tab, click the ‘Input Mask’ property box.

3. Click on the ‘Build’ button to start the ‘Input Mask’ wizard.

4. In the ‘Input Mask’ list, select the type of the mask that you want to add.

5. Click on the ‘Next’ button and finish the wizard.

6. Now, open the table in the datasheet view. Try to type the text in the masked field. The typing
text is seen in asterisks.
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Recap:

o In the Design view, you can enter the field names, their data types and description using the ‘Grid’

pane and set the field properties using the ‘Field Properties’ pane.

o Data can be entered into the table using the Datasheet view. When you double-click the table

name in the database window, the table opens in the Datasheet view.

o Microsoft Access allows users to hide and unhide table fields. Hiding a data field means keeping

it out of sight. This feature is useful in situations where a user likes to see two non-adjacent fields

together.

o Users can find and replace data. To find, users need to give a ‘keyword’ to search in the entire

large database.

o To replace, users need to enter the alternative word for the keyword.

o MS Access uses routines called ‘Validation Rules’ that check for correctness, meaningfulness

and security of data.

o Field validation rules specify a criterion that all valid field values must meet.

o Record validation rules specify a condition that all valid records must satisfy.

o You can compare values across different fields using a record validation rule.

o Open the ‘Property’ sheet showing ‘Table Properties’. The validation rule added here is applicable

to all records of the table.

o MS Access offers an auto-increment feature. When applied to a numeric data field, a sequential

number is generated automatically whenever a new row is added.
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